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Disclaimer

This training material is presented without warranty of any kind, either 

express or implied respecting the contents of this book, including but not 

limited to implied warranties for the book’s quality, performance, 

merchantability, or fitness for any particular purpose.

Standard Legal Notices

Copyright

Presentation and workbook copyright 2024 by Multi Business Solutions. All 

rights reserved. Printed in the United States of America. No part of this book 

may be used or reproduced in any form or by any means without prior written 

permission of Multi Business Solutions. Material remains the property of 

Multi Business Solutions.

Trademark Acknowledgments

All product names and services mentioned in this workbook are trademarks or 

registered trademarks of their respective companies. Multi Business 

Solutions is not affiliated with any of these companies.



About Your Trainer

Certified QuickBooks ProAdvisor Natalie Remund

Natalie is a certified QuickBooks expert who can guide you through the 
maze of efficiently running a business. Natalie has been providing 
QuickBooks training to a variety of businesses for over 5 years. Natalie 
earned her Bachelor’s degree from South Dakota State University in 
Brookings, SD.

The Multi Business Solutions team will help you master QuickBooks and 
ensure your financial information is accurate and timely; better yet they will 
arm you with critical knowledge of how to use the data to improve company 
performance.

Multi Business Solutions
218-770-2691
office@multi-business-solutions.com
www.multi-business-solutions.com
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QuickBooks® Desktop Foundations

Important Information About the Structure of this Training.

Today’s course is intended as the foundation for using QuickBooks® as a bookkeeping, 

business management and cash flow building tool. The material provides a critical basis for 

establishing bookkeeping best practices and ensuring accurate financial information.
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Please ask questions throughout the presentation.

Your Instructor is also available for one-on-one consultations.

In addition to what you will learn today these manuals are for use as a

post-class reference guide.

We are happy you are here today and look forward 

to helping you master QuickBooks!



QuickBooks® Desktop Foundations

The most important reason to advance our knowledge of QuickBooks® and basic 
bookkeeping principles, whether you are a business owner or employee, is to improve 
business performance.

While we identify specific learning objectives at the beginning of each section,

3 Overall Objectives include:

1. Introduction to basic features in QuickBooks and how they apply to best practice 

bookkeeping principles.

2. How to effectively and efficiently use QuickBooks to manage daily bookkeeping tasks 

and develop an understanding of how the data is entered, processed and reviewed.

3. How to customize QuickBooks to meet the specific needs of a business.
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Why we teach Cash Flow with QuickBooks®:

Business owners typically identify Cash Flow as their number one area of concern. 

QuickBooks Accounting Software, when utilized correctly, allows users to run Cash Flow 

projections and develop a Cash Flow management strategy to prevent shortfalls. This 

training will help participants develop a strong knowledge base of how to use QuickBooks 

reports to manage a business and build cash flow.

The foundation of business success is in the daily use of accurate, real-time financial data.

What we measure, we manage; what we manage, we improve.



QuickBooks® QuickBooks Desktop Foundations

It is important to focus on the areas of our business that contribute most to profitability.
QuickBooks helps us easily identify areas of focus if we know where to look.

The 80/20 rule, or the ‘Pareto Principle’, is a powerful concept that consistently rings true.

In most cases, 20% of our customers generate 80% of our net profit. At the same time, 
20% of the goods or services we sell contribute 80% of our revenue, etc. You get the idea.

The most important value good bookkeeping brings to a business is an understanding of 
where to focus.

By generating daily reports that uncover the best customers, jobs, services, or products, 
you will soon see how you can refocus your internal efforts on doing highly valuable work.

Accurate real-time data with one click reports, is an enormous benefit of using
QuickBooks® the ‘right-way’.
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Section 4 Objectives

Upon completion of section 4 each participant will become familiar with the following 

objectives:

• How to use credit memos and apply credits.

• How to issue refunds to customers.

• How to use the Income Tracker to manage Accounts Receivable.

• How to create Sales and Accounts Receivable related reports.
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Credit Memos

Credit Memos are used to clear out uncollectible invoices, to clean up odd transactions in 

Accounts Receivable or to refund a customer.

Click Refunds & Credits from the Home Page or open the outstanding Invoice and click

Refund/Credit in the Ribbon bar.

This will populate a credit memo based on the original invoice. You will need to adjust the 

credit memo to reflect the actual credit amount. Verify that the date of the credit memo is 

in the current period.

Click Save & Close.
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Credit Memos

The Available Credit window will appear with the options to Retain as an available credit, 

Give a refund or Apply to an invoice. Note: Do not ignore these options. We will apply the 

credit to an invoice.

The Apply Credit to Invoices window will appear. This window gives you the option to 

select the invoice you wish to apply the credit memo.

Verify the selection and click Done.

Once the credit memo is applied to the invoice, the invoice will show as paid and no longer 

appears on Accounts Receivable Aging reports.

13 QuickBooks Desktop Foundations



Apply Credits

Some credits remain open for customers who will require additional services rendered or 

products ordered in the future. Maybe we received a payment on account before the 

invoice was created?

Apply an existing credit to a new invoice.

Click Create Invoices from the Home Page and apply existing credits when prompted or

open an existing invoice and click Apply Credits in the Ribbon Bar.

Select the Customer: Job and enter required information. Click Save & Close.

14 QuickBooks Desktop Foundations



Apply Credits

Verify that the credit is selected in the Apply Credits window. 

Click Done -> Save & Close.
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Apply Credits

Applying existing credits to open invoices can be accomplished by receiving a zero payment 

and applying the existing credit. Discounts can be given to customers in the receive 

payment window.

Click Receive Payments from the Home Page.

Select a Customer: Job.

Click Apply Credits in the unused credits window to apply credits across all jobs for a 

customer or click Discounts and Credits to add a discount or apply an existing credit.

16 QuickBooks Desktop Foundations



Issue Refunds

In rare instances it is necessary to refund a customer. Determine whether the credit is from 

a prior payment received or a credit memo created.

Issue a Refund from a Payment.

Locate and open the payment. Notice the Overpayment window reflects a credit of $75.00

for this payment.

Select Refund the Amount to the Customer.

Click Save & Close.

The Issue a Refund window will appear.

Enter or Verify the information in the window. 

Click OK.
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Issue Refunds

Issue a refund from a Credit Memo. 

Locate and open the credit memo. 

Click Use Credit to Give Refund.

The Issue a Refund window will appear.

Enter or Verify the information in the window. 

Click OK to return to the Credit Memo.

Click Save & Close.
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Income Tracker

The Income Tracker is a great way to manage Accounts Receivable. It allows you to track all 

Estimates, Sales Orders, Time & Expense, Open Invoices and Overdue Invoices. To access 

the Income Tracker from the Menu Bar, click Customers -> Income Tracker.

The Income Tracker can also be accessed from the Ribbon Bar in the Customer Center.

Click a Colored Block or Column Heading to sort information. Use the Filter feature to 

select and display specific information. Use the Action options to print or email forms. Click 

the Gear Icon to add Unbilled Display Settings.
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Sales and (A/R) Reports

Now that we have mastered the Accounts Receivable section of this training, we are ready 

to memorize reports that support the 80/20 rule and help us manage our Accounts 

Receivable. Click Reports in the Menu Bar. Click Sales.

Sales by Customer Summary – Informs us of the top 20% of our customers that bring in

80% of our revenue. Click Customize Report to edit the following:

• Show Columns - Total Only.
• Sort By - Total.
• Sort In - Descending Order.

Sales by Item Summary – Provides a historical glimpse of the best-selling products and 

services for a period. This report includes QTY, Amount, % of Sales, Avg Price, COGS and 

more. Click Reports in the Menu Bar. Click Customers & Receivables.

A/R Aging Detail – Informs us of the outstanding balances for our customers and whether 

they are current or past due. Remember, the number of days it takes to collect a payment 

has a direct affect on cash flow and, the older the invoices are, the more costly the 

collection process becomes.

Open Invoice Report – This is a great report to maintain open invoices, outstanding credits 

and payments that have not been applied to invoices.

Note: Click the Memorize button in the Ribbon Bar for each report and save them in your 

memorized report group in the Memorized Report List.

20 QuickBooks Desktop Foundations



Statements

Statements are typically sent to customers with outstanding invoices. This process should 

be part of your Accounts Receivable/Collections Policy.

Click Customers in the Menu Bar.

Click Create Statements.

The Select Statement Options focus on the dates related to the history you wish to display 

on the statement. The Select Customers section provides the options to preview, print or 

email a statement for one customer, multiple customers or all customers.

Select Additional Options 
allows us the ability to 
customize the statement 
template.

Select display options to 
filter criteria.
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Statements

Payment Reminders

A new 2021 feature provides the ability to schedule and send statements to specific 

customers. You can access this feature from the Create Statements window and clicking the 

Go to payment reminders.

Create a new reminder schedule and auto-send statements to a pre-defined customer list.
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Statements

Customer Groups
A new 2021 feature provides you the ability to create groups of customers and create schedules to 

automatically send statements.

Click Customers (Menu Bar) -> Payment Reminders -> Manage Customer Groups.

Click Create customer group.

Follow the 3-step process:

1. Enter details to create a new group

2. Select Fields

3. View and Select Customers.
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Section 5 Objectives

Upon completion of section 5 each participant will become familiar with the following 

objectives:

• How to create and apply Vendor Credits.

• How to use Bill Tracker to manage Accounts Payable.

• Receipt Management

• How to view and save Accounts Payable related reports.
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Vendor Credits

On occasion we will receive a credit from a vendor for returned merchandise or due to an 

error in billing. Tracking and applying vendor credits or discounts can impact your cash flow 

in a positive way.

Click Enter Bills from the Home Page just like you would when entering a bill. 

Select Credit.

Enter the following information:

Vendor Name, Date, Ref No, Credit Amount and Account. 

Click Save & Close.
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Apply Vendor Credits

Tracking and applying vendor credits has a positive impact on cash flow.

Click Pay Bills from the Home Page. Select the Vendor with outstanding credits.

Select the vendor to auto apply the credit (depending on preference settings) or select the 

vendor -> click Set Credits button.

Verify selected credit and Credits Used in the Discounts and Credits window.

Click Done and complete the Pay Selected Bills process.
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Bill Tracker

The Bill Tracker is a great way to manage Accounts Payable. Track all Purchase Orders, 

Open and Overdue Bills. To Access the Bill Tracker from the Menu Bar,

click Vendors -> Bill Tracker.

The Bill Tracker can also be accessed from the Ribbon Bar in the Vendor Center.

Click a Colored Block or Column Heading to sort information. Use the Filter feature to 

select and display specific information. Use the Action options to perform a task.
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Receipt Management

Receipt Management is a new feature for 2021 that allows you to upload and manage 

receipts. You can now browse or snap and upload your receipts (jpeg, jpg, pdf or png 

format) and review them before adding to your register.

You will need an Intuit account to setup and use this feature. The same account you setup

when you installed your QuickBooks Desktop version and created your company file.

Click Vendors from the Menu Bar -> Receipt Management. Enter your account login name 

or email. Click Continue.
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Receipt Management

Browse your computer, Setup Email to send receipts or install the snap on mobile app to 

snap pictures of receipts and send them to the Receipt management center in your 

company file.

Click the Manage Users button to provide access for individual users.

Click the Gear icon to change the columns displayed in the Receipt Management Center.
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A/P Reports

Now that we have mastered the Accounts Payable section of this training, we are ready to 
memorize reports that help us manage our Accounts Payable.

Click Reports in the Menu Bar.

Click Vendors & Payables.

Click and open the following Reports:

A/P Aging Detail – Informs us of the outstanding balances for our vendors and whether 
they are current or past due. Remember to pay bills timely to avoid finance charges.

Unpaid Bills Detail – This report displays all outstanding bills and credits, sorted by vendor. 

This is a great tool for budgeting. Use this report to determine the total for all bills due 

before or on the next bill-pay date.

Sales Tax Liability – Populates sales tax liability based on sales receipts and invoices. This 
report will track liabilities based on state or county. Use this report to submit state sales tax 
returns.
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Note: Click the Memorize button in the Ribbon Bar for each report and save them in your
memorized report group in the Memorized Report List.
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Payroll Objectives

Upon completion of this Payroll training each participant will be familiar with:

• Overview of Payroll.

• How to setup Payroll.

• How to run Payroll.

• How to manage Payroll taxes.

• How to process Payroll forms.

• How to create and review Payroll reports.

Sushi Coma has decided to outsource the payroll function to a third-party payroll service, a 
very common practice in most industries. They are using the Semi-Monthly option verses 
Weekly option, to reduce the number of payrolls and keep the payroll expense in control, 
(another important aspect of good cash flow management). Daniel and Meredith have hired 5 
employees for each location. This includes a head cook, prep cook, server, server/cashier, and 
driver.

Payroll is typically one the largest expenses in a business, and it is critical to implement sound 
payroll management strategies. Payroll has many elements business owners tend to overlook. 
Let’s walk through an overview of the payroll process, then dive in and set up sound business 
practices around this important function.

33



Payroll Overview

Throughout the year, many business owners are required to process payroll, pay taxes and file 

forms with the Internal Revenue Service and their state agency. How business owners 

determine the status of an individual (employee vs. contractor) depends on the nature of the 

services they provide.

There are three tests that can be used to determine status of employment.

Control Test – The employer has the right to tell the employee what to do.

Integration Test – The work done is an integral part of the business.

Multiple Test – The individual must wear the company’s uniform and be available for work 

when needed.

Visit Irs.gov for more information and requirements for employing individuals.

https://www.irs.gov/newsroom/understanding-employee-vs-contractor-designation

Once a business owner hires employees, it is important to create an Employee Handbook, 

complete the employee/payroll setup process and follow best practice procedures. Many 

owners struggle with this process as it is one of the highest expenses in a business.

Cash flow is critical in order to avoid late payroll tax payments, unnecessary penalties and 

interest. Outsourcing this process to QuickBooks full-service payroll is highly recommended. 

This helps avoid unnecessary costs or fees and keeps the business owner in compliance.
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Payroll Setup

Payroll setup in QuickBooks Online requires turning on the feature and selecting a 

subscription. We will not turn on Payroll during this training. However, we will discuss the 

process and required information needed.

First, you will need a Federal Identification Number, typically setup when you open a business. 

(It is also used to open bank accounts.)

Second, you will need an EFTPS.gov account and login. This requires you to enter owner and 

bank info and allows you to process tax payments online.

Third, you will need to contact your state agency to address all filing requirements (varies per 

state).

Next,  gather the following information from employees. Visit www.irs.gov for additional 

information and to download forms.

I-9  Employment Eligibility Verification – Verifies the identity and employment authorization 

of individuals hired for employment in the United States. This requires two specific forms of 

identification. Business owners must maintain this information for all employees and provide 

it if requested by the U.S. Citizenship and Immigration Services.

W-4 - Used by employers to determine how much federal income tax to withhold from an 

employee’s pay. https://www.irs.gov/pub/irs-pdf/fw4.pdf

Publication 15 (Circular E) – If you have questions about IRS payroll requirements, refer to 
https://www.irs.gov/forms-pubs/about-publication-15. It is a great resource.

California Employers Guide
https://edd.ca.gov/pdf_pub_ctr/de44.pdf
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Run Payroll

In order to run payroll,  select one of the following pay period options:

Semi-Monthly – This option requires 2 pay periods a month, 24 per year. Semi-monthly is 

typically selected by higher-level professional businesses. For example, a pay period would be 

from the 1st to the 15th (paid on the 20th ) and 16th-30/31st (paid on the 5th). There are 88 

hours in a pay period.

Bi-Weekly – This option means payroll is paid every two weeks. 2 months a year employees 

receive three paychecks for a total of 26 per year. This method is more common with hourly 

employees and equates to an 80 hour pay period. 

Weekly – This option means payroll is paid per week, for a total of 52 per year. This method is 

commonly used amongst contractors, roofers, plumbers etc. 

There are 2080 hours in a year for full-time employees, regardless of which option you 

choose. It is recommended to research the options prior to running your first payroll. Yes! It is 

possible to change a payroll processing period. 

Something to consider - A business has costs associated with processing payroll. It is 

important to establish an efficient routine or outsource the payroll function.
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Payroll Taxes

When each payroll is processed, the individual W-4 information is used to calculate federal 

taxes for each employee. The employer withholds Federal and State taxes, then calculates the 

employer's portion and processes payments online. 

Employee calculations (provided access to pay stubs each payroll)

Number of hours x pay rate = Gross Payroll

Subtract Federal Employee Taxes 
• Federal Income Tax – IRS Table and W-4
• Social Security 6.2%
• Medicare 1.45%

Subtract State Employee Taxes (depends on the state)
• State Income Tax 
• State Disability Tax 

Equals Net Payroll, the amount paid to the employee.

The employer then adds the following to calculate the Federal and State Liability (amounts 
owed by the employer): Due dates are determined by the agencies.

Total Federal Tax Liability (due date determined by the IRS)
• Federal Income Tax - Employee
• Social Security – Employee
• Social Security – Employer 
• Medicare Employee
• Medicare Employer
• Federal Unemployment

Total State Tax Liability (due quarterly) State Income Tax
• State Disability
• State Unemployment
• State Employer Training Tax
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Payroll Tax Forms

Quarterly

941 (Internal Revenue Service)

Reports Gross Wages, Federal Income Tax, Social Security wages and taxes, Medicare wages 

and taxes, tip wages, employer liabilities and payments paid.

Sushi Coma, Inc. is located in California, thus we have included key forms relevant to 

California state reporting requirements, but they are available for every state.

DE-88 (California Employment Development Department)

DE 9 (California Employment Development Department)

DE 9C (California Employment Development Department)

Reports wages, state taxes withheld, and state taxes paid.

Yearly (in additional to quarterly reports)

W-2 (Social Security Division) – Reports all employee wage information used to file individual 

tax returns.

W-3 (Social Security Division) - Reports summary of W2’s reported.

940 (Internal Revenue Service) – Reports employer federal unemployment for all employees.
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Payroll Reports

Many business owners use third party time tracking apps to track individual employee time. 

These apps sync with payroll processing in QBO, making the process quick and efficient.

There are many payroll reports used to manage payroll. Payroll reports commonly used in 

QuickBooks Online are as follows:

Time tracking reports – Tracks time per employee per time period.

Payroll Summary – Provides summary view of information per employee and pay period.

Payroll Details – Provides details per employee per pay date and totals per pay period.

Tax and Wage Summary – Tracks total wages, taxable wages and tax amount by category.

Best practices: Keep good records of time tracking and payroll reports per pay period. 

Business owners often fall behind in making timely payroll tax payments and the penalties add 

up quickly. One more reason to invest time in understanding cash flow and establishing best 

practice procedures.
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Module 5 Goals

Upon completion of Module 5, each participant will be familiar with:

• How to setup sales tax.

• How to manage the Sales Tax Center.

• How to review sales tax reports.

• How to file sales tax returns.

Express Landscaping is required to track sales by county as they provide services in 

multiple counties. While much of what Express provides is service oriented and not 

taxable, they do sell items such as fountains, trees, shrubbery, etc. that are taxable.

In California, where Express is located, there is a statewide tax rate plus city and 

county sales tax rates. Express is required to file a sales tax report monthly and pay 

the balance to the state of California. Express has the option of purchasing products 

wholesale and paying sales tax at the time of purchase. The benefit of this strategy is 

to avoid having to submit sales tax reports. They will build the fee into the price they 

charge customers. However, to demonstrate the sales tax feature, in this training 

Express will charge customers sales tax at the time of  purchase using custom rates.

Here is the good news, QuickBooks has sales tax rates built into the application for 

each area of the country and tracks the information for you. QuickBooks also enters 

the information on forms such as sales receipts. When this feature is setup correctly, it 

easy to keep track of what is owed; in addition, it will help Express remain in 

compliance with monthly reporting requirements and prevent late fees. 
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More on Sales Tax
Sales tax is calculated on the sale or lease of goods and services in the United 

States. Sales tax rates are state regulated, and percentages vary across the United 

States. Sales tax is calculated by multiplying the purchase price by the applicable tax 

rate. The seller collects the tax at the time of sale and tracks the amounts collected. 

Each month, quarter or year the information is reported, and amounts collected are 

paid to the Department of Taxation for the state in which the taxable good or services 

were provided. It is the business owner’s responsibility to collect, report and pay all 

sales tax collected.

Another form of sales tax is referred to as Use Tax. This tax is reported and paid when 

a business owner does not pay tax on products purchased. For example, online 

vendors or suppliers do not always charge sales tax, therefore the business owner is 

responsible for keeping track of use tax. (Refer to Department of Taxation for your 

state.)

When you purchase or lease goods and pay the sales tax at the time of purchase, you 

are not required to collect sales tax from your customers. If you do not pay the sales 

tax at time of purchase, you are required to charge your customers' sales tax. 

WOW! In California, a 10 percent penalty is assessed if you do not file your sales tax 

return by its due date. Ongoing Interest is based on the interest rate shown at the 

bottom of your return, for each month or partial month that the tax remains unpaid. 
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Sales Tax Setup
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Manage Sales Tax

Managing sales tax will increase the accuracy of data for state filing.

View sales tax activity, pay sales tax, access reports, edit settings and rates from one window.

Click Vendors from the Menu Bar -> Sales Tax -> Manage Sales Tax.

Adjust Sales Tax Preferences, Review Reports and Review Items and Code Lists.

Note: Invoices or Sales Receipts are required to properly calculate sales tax collected. It is 

important to verify the Sales Tax Liability and Sales Tax Revenue reports before filing with 

your state agency. You are required to manually maintain all sales tax rates in QuickBooks®.



Sales Tax Setup

44

Click the Pay Sales Tax button to write and/or print a sales tax liability check. It is important 

to pay your sales tax liabilities through this window as it maintains proper balances within 

QuickBooks®.



Sales Tax Setup

9. Complete the filing frequency -> Next agency. Add the filing frequency to all 

additional agencies then click Save.
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Sales Tax Center

Once the Sales Tax Center is activated you can manage Sales Tax Settings, filter by 

status or tax period, run reports and view returns. 
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Sales Tax Center

1. Click sales tax settings to add tax agencies, select the state, city, or county to match 

your agency. 

2. Next select the filing frequency you are required to file, select the start date and 

reporting method. A sales tax liability will auto-populate in your chart of accounts.

3. Click Save. 

Important! You need to know your state’s reporting method. Accrual means you are 

responsible for collecting and paying tax in the same period or date range a sales form is 

created. Cash means you are required to pay the tax for the period you collect the sales tax 

from your customers.

4. Edit the tax agency or click the down-arrow under the action menu to make it inactive.

5. Add the custom tax rates for California. 
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Sales Tax Center

Although the sales tax agency populated using the address and zip code in accounts 

and settings, you can add custom tax rates. It is important to change each invoice 

and/or sales receipt default sales tax when using custom sales tax rates. This will be 

addressed in the accounts receivable module of this training. Choose Combined, San 

Diego, County Tax (Rate 1 6.25%) and District Tax (Rate 2 1.5%), California 

Department of Taxation for both. Total combined tax rate is 7.75%.
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Sales Tax Reports

1. Click Reports from within the Sales Tax Center to view Tax liability, Taxable 

customer, and Nontaxable Transaction Review reports.

Tax Liability Report provides the information required to complete tax forms per 

state. Select the date range you are required to report, tax agency and accounting 

method.

The accounting method is based on your state’s requirements.

Reference the Taxable customer report to manage tax status and rate defaults for 

each customer.

Use the Nontaxable Transaction Review report to verify taxable transactions were 

not missed by mistake.

2. Click Reports from the left navigation bar -> standard -> search ->tax to view 

list of available reports: Locate and save the following reports as favorites by clicking 

the star to the right of each report:

• Sales Tax Liability Report

• Taxable Sales Summary

• Taxable Sales Detail
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Sales Tax Filing

1. From the Sales Tax Center, click View tax return. 

2. Click the + Add an adjustment link, if you need to adjust the balance due.

3. Click Record payment to create a transaction and post to your bank register. It is 

important to record all sales tax payments using the record payment option in the 

Sales Tax Center. 

4. Complete the following instructions. Most state tax agencies have an online system 

for completing filing requirements and making payments.
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Module 10 Goals

Upon completion of Module 10 each participant will be familiar with:
• How to save and group custom reports.
• How to setup and review a Balance Sheet Statement.
• How to setup and review a Profit & Loss Statement.
• How to setup and review a Cash Flow Statement.
• How to use Financial Statements to track key performance indicators.
• How to create a report and utilize Ask My Accountant.
• How to review an audit log.
• How to set a closing date and password.

The importance of understanding and utilizing financial reports cannot be overstated. 
Many business owners are embarrassed to admit their lack of knowledge when it 
comes to understanding what their numbers mean. Financial statements provide a 
snapshot of a business’s  financial health, giving insight into its performance, 
operations, and cash flow. They are essential and provide information about a 
company's revenue, expenses, profitability, and debt. 

As we break down the numbers for Chris, she will soon learn; it is not rocket science 
as she watches the numbers take on meaning. Chris has never been able to determine 
whether her business is considered healthy. Now that the reconciliation process is 
complete and she can trust the numbers, she begins to understand how much 
information is available to help her continually improve company performance. In fact, 
Chris finds herself saying, “Why didn’t I know this earlier? This would have changed 
everything”. 

Methodical action steps will put Chris back on the right track. Experience what it must 
feel like to have the blinders removed and see a clear picture of how to grow and 
thrive!
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Understanding Your Numbers

Customizing and viewing reports on a regular basis will ensure the accuracy of 
your company data, and help you make better management decisions. Financial 
analysis and reporting are the bedrocks of modern business, and the benefits 
are vast; improved cash flow, debt and liabilities management, trend 
identification, real time tracking, etc. Financial reports also help you remain in 
compliance with various regulations.

The Custom Reports section allows you to save custom reports in groups and 
streamline the time it takes to review reports daily, weekly, monthly, etc.  

Once you understand what the numbers mean in your reports and where the 
data is coming from, it will become obvious why creating unnecessary account 
categories leads to costly cleanup. The various reports clarify what is going on in 
each area of our business. Invest time to familiarize yourself with key reports that 
apply to your business. If you are unsure what reports to track, talk to your 
instructor/advisor or accountant for advice. Keep in mind you can customize and 
create detailed and summarized reports as you learn more.

All business owners should focus on three main financial reports:
• Balance Sheet
• Profit & Loss
• Statement of Cash Flows

Other important reports include:
• Ask My Accountant
• Audit Log
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Balance Sheet
The Balance Sheet provides information about the assets the business owns. There are 

several types of assets including current assets, cash in the bank and money owed by 

customers. Fixed assets are tangible items purchased, such as a vehicle or equipment used 

to produce money. Fixed assets are depreciated over time and are typical items that cost 

more than $2,500. Other assets include leasehold improvements, purchase of a business, 

security deposits, etc.

Now let’s discuss liabilities, what the business owes. Short-term liabilities are paid within a 

year and include sales and payroll taxes, garnishments, lines of credit, credit cards etc. 

Long-term liabilities take more than a year to pay back and include vehicle or equipment 

loans, SBA or building loans etc.

Finally, the equity section tells us how much your business is worth, tracking all profits and 

losses from the time you start the business to the present. This section tracks all the stock, 

owner distributions and contributions over the years. All information is rolled into retained 

earnings, owner's equity, or member equity depending on the type of entity.

1. Click Reports in the left navigation bar -> select the standard tab -> scroll to 

business overview -> Balance Sheet.  

2. Click the star to save the report as a favorite or

3. Click reports in the left navigation bar and use the search feature. Select the Balance 

Sheet.
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Balance Sheet

Balance Sheet
There are several ways to filter the data for your custom reports. Change the Report 

period, Display columns, Show non-zero or active only, Accounting method, and

Compare Report periods.

The Collapse option consolidates all sub-account balances within the main account. 

The Expand option displays all sub-account balances. Sort by ascending or 

descending order and Add notes. Click the appropriate icon to Email, Print or Export

a report.

1. Click Customize to change the date range, accounting method and negative 

numbers display.

55



Balance Sheet

2. Click Rows/Columns to change the way columns are displayed, Show non-zero rows 

and columns, or add percentage of rows and columns.

3. Click Filter to select specific Customers, Vendors, or Product/Service items to be 

displayed.

4. Click Header/Footer to add your logo, change the Report title, remove information 

displayed, and change the alignment of the report. Click Run Report.
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Balance Sheet

5. Click save customization.

6. Name your custom report or use the default name, add this report to a group, or 

share it with a coworker. Organizing your reports in groups will save time locating 

and reviewing your favorite reports. 

7. Click Save.

8. Now simply click on Reports -> Custom reports to quickly access your customized 

Balance Sheet.  
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Balance Sheet

This sample displays the assets portion of the Balance Sheet. In order to rely on your 

financial data, it is important to verify that all asset account balances are accurate.
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Balance Sheet

This sample displays the liability and equity sections of a Balance Sheet. In order to 

rely on your financial data, it is important to verify that all liability and equity account 

balances are accurate. 
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Profit & Loss
Profit & Loss
The Profit & Loss Report is an accumulation of income and expenses for a period. At 

the end of each year the net profit or loss rolls into the equity section of the Balance 

Sheet.  Each new year starts with a zero balance for income and expenses.

The profit & loss continues with the story about the health of our business. Are we 

meeting our sales growth targets? When we subtract expenses directly related to 

revenue, we can determine our gross profit margin. Do we have enough gross profit 

to pay all other costs? When we subtract all other expenses from gross profit, we can 

determine net income before tax and whether we are profitable. Each category is a 

percentage of Income which we use as a cash management tool.

1. Click reports in the left navigation bar -> reports -> standard.

2. Scroll to business overview.

3. Click Profit and Loss % of Total Income or use the search feature.
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Profit & Loss

4. Click Customize.

5. Change the Negative numbers to display with parenthesis and check the box 

Show in red.

Just like the Balance Sheet, you can add rows and columns, filter information, or 

change Header/Footer options.

Note: It is important to choose the same date range and accounting method used to 

customize the Balance Sheet.
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Profit & Loss

6. Use the collapse/expand feature to hide or unhide subaccounts when customizing 

reports.

Note: Remember to click save Customization and add this report to your new report 

group in custom reports.  
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Cash Flow

Business Tip:  Cash flow includes all transactions that go in and out of your bank 

accounts. Some transactions will post to the Balance Sheet, and some will post to the 

profit & loss.  
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Statement of Cash Flows

Cash flows are used to project the future cash needs of a business. Best practice 

accounts receivable and accounts payable policies can greatly improve cash flows. 

Cash flow is the money that flows in and out of your bank account regardless of 

whether it is income, expense, receivables, payables, loan or credit card payments. 

This means that both the Balance Sheet and Profit & Loss are directly related to the 

cash flowing in and out of the business. By contrast, net profit is directly related to 

income and expense activity.

In most small businesses, revenue typically doesn’t match up with spending, so 

understanding your cash flow is critical to avoid a cash flow crisis. The Statement of 

Cash Flows helps you evaluate whether there is enough money coming in, as well as 

enough cash on hand, to pay bills. 

A Statement of Cash Flows is a tool used to attract new investments, inform your 

fundraising efforts, and get more access to financing options. This statement provides 

banks and creditors some reassurance that your small business can pay back loans or 

fund its own operating expenses.

Let’s break it down.
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Statement of Cash Flows

The first line item on your Statement of Cash Flows is net income from the Profit & 

Loss. Since accounts receivable reflects income that has not been collected from 

customers, we subtract it out. It is cash we have not yet received. Inventory has not 

been sold and sits as an asset on your Balance Sheet, therefore we subtract the 

amount. Accounts payable represents bills that have not been paid (we have not spent 

the cash), thus we add it back. Credit card, loan balances and taxes owed have not 

been paid, so we add them back. These categories reside on the Balance Sheet. This 

provides a cash picture and demonstrates how cash flow is reflected on both the 

Balance Sheet and Profit & Loss. All three statements work together to help determine 

the cash position of a business. This section of the Statement of Cash Flows is 

referred to as operating activities.
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Statement of Cash Flows

The next section represents investing activities. Original cost of assets is subtracted 

from the net profit. The original cost of assets include investments acquired to help 

produce revenue, such as a truck. The goal is to see a return on your investments. 

Next, we add and subtract financing activities from the net profit. Financing activities 

include loans we owe over a period of more than one year. Opening balance equity is 

populated when you link a new bank or credit card account that has a balance. This is 

a temporary holding spot.

Finally, we can see the cash we have at the end of a period. This balance should 

match the cash balance on the Balance Sheet (cash basis). This includes undeposited 

funds.
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Key Performance Indicators (KPI)

What is a Key Performance Indicator (KPI)? 

A key performance indicator is a measurable value that demonstrates how effectively a 

company is achieving key business objectives. Organizations use KPIs at multiple 

levels to evaluate their success at reaching targets. High-level KPIs may focus on the 

overall performance of the business, while low-level KPIs may focus on processes in 

departments such as sales, marketing, HR, support and others. 

As business owners, we use the Balance Sheet and Profit & Loss information along 

with mathematical formulas to determine KPIs, then we compare those numbers to our 

specific industries. This process helps us set targets and goals in many areas of our 

business. We must emphasize the importance of accurate financial statements to 

assist in setting accurate and achievable goals.

Let’s review a few examples of the different types of KPIs:

Sales Growth Rate – Measures the pace your sales revenue is decreasing or 

increasing. This metric is an essential factor in growth projections and setting sales 

targets. It will help your business account for monthly or quarterly spikes. 

Note: The number of months in the “period” must be the same for the current period 

and the previous period, e.g., one month, three months, twelve months.
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Key Performance Indicators (KPI)

Gross Profit Margin – Measures the amount of profit your business makes on each 

dollar of sales before any operating expenses. It takes into account costs directly 

related to Sales or Cost of Goods Sold.

Net Profit – The amount of money left over after deducting all expenses and costs. 

This is one of the most important KPIs used to determine if there is enough profit to 

compensate the owners.

Accounts Receivable Days or Days Sales Outstanding (DSO) – measures how many 

days on average it takes a business to collect money from its customers.
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Key Performance Indicators (KPI)

Accounts Payable Days – A measure of how long it takes a business to pay its bills.

The best-case scenario is to make it easy for your customers to pay. It is also 

important to strategically manage when you pay your bills. If you pay them close to the 

due date (and avoid paying late fees) you hold onto your cash longer, a wise cash flow 

strategy. It is critical to establish and implement solid accounts receivable and 

accounts payable management policies.

Accounts Payable Days - Accounts Payable [Balance] x Month Length [30 or 31 

days] / Total Cost of Sales [total in Cost of Goods Sold]

Current Ratio –Compares total current assets to total current liabilities. The ratio 

indicates whether we have enough cash to pay all short-term debts.  
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Key Performance Indicators (KPI)

Quick Ratio – Measures the availability of assets which can quickly be converted to 

cash to cover current liabilities. Inventory and other less liquid current assets are not 

included in this calculation. Both ratios are reviewed by banks and creditors when 

evaluating a business loan application.

Cash on Hand – A measure of the cash and cash equivalents in actual possession by 

the business at a particular time. 

Chris Craig has set a goal of accumulating 3 months of operating costs to set aside as 

liquid cash (an emergency fund). In addition, she would like to build the payroll account 

to cover lean times. Once the goal is determined, a cash on hand metric is created and 

monitored. 
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Balance Sheet - KPIs

Let’s take another look at the Balance Sheet and how we use the information to 

calculate KPIs. Notice cash on hand is very low indicating the need for cash 

management. The accounts receivable and payable days need to be determined. The 

current ratio [Total Current Assets / Total Current Liabilities = 1.6 and appears low. 

The higher the number the better. Managing cash and consistently building our savings 

as well as keeping accounts receivable and accounts payable low, will drastically 

improve the ratios.
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Profit & Loss KPIs

Now let’s look at the profit & loss KPIs. We do not need to do much math to determine 

gross profit and net profit margins. Our gross profit is 96.03% which appears high. How 

do we know it is high? We compared our numbers to industry standards. Talk to your 

advisor for tips on where to find industry standards. When we take the gross profit and 

subtract total expenses, we can determine net income and the related percentage. 

Here we show 16.43%. 
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Ask My Accountant

This report can be a very helpful tool. It is used to post transactions when the user is 

not sure which category to use. The memo field allows the user to post notes and 

questions for their accountant. It can be a great way to train a new bookkeeper or 

business owner.

1. Click on accounting in the left navigation bar -> chart of accounts tab. 

2. Locate Ask My Accountant in other expense type, then click run report.

3. Click customize -> header/footer to change the header to Ask My Accountant.

4. Change the Report Period to All Dates then click Run report. 

5. Save Customization to save your report in custom reports.

Notice the Accountant’s response in the Memo/Description field to post the 

transaction to Fixed Assets/Computer Equipment.

Note: It is important to clear up all transactions on this report before year end and 

especially before filing a tax return. This is a placeholder for transactions that need 

more information to post in the correct account or category.
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Fraud Prevention

Fraud is a serious problem for small business owners and the statistics are startling. 

According to a survey by AFP (Association for Financial Professionals), fraud hit an all 

time high. 82% of U.S. businesses reported experiencing payment fraud. 

We hope this got your attention; it should. Fraud prevention must be addressed and 

given serious consideration as you work to build a solid financial foundation in your 

business. The good news is, QuickBooks Online has tools built into the application 

designed to help you implement fraud prevention processes to detect and prevent 

fraudulent activity.   

Fraudulent activity can take on many forms, including asset misappropriation, billing, 

expense reimbursement, skimming, cash register disbursements, and check tampering 

schemes to name a few.

Biz Q&A:  
• How do you prevent fraud from occurring in a business?
• How do you identify areas where the likelihood of fraud is the greatest? 
• How do you protect your business assets and cash? 

Wow!
According to the Association of Certified Fraud Examiners, the average 

business will lose approximately 7% of revenues due to employee theft. Small 

businesses have a 38% greater amount of fraud than larger companies, due to 

lack of internal controls.

Once your accounting application is set up, we recommend you seek the advice of an 

accountant to verify you are taking full advantage of the fraud prevention tools in QBO 

and ensure you have internal controls built into your system.
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Audit Log

The Audit Log Report is a good way to view activity by user. This is a great training tool used 

to enforce accurate data entry. The audit log is also a way to detect fraudulent activity. 

1. Click reports -> search audit log.

2. Click the Filter button to search historical transactions by User, Date, or Events.

Notice the filter criteria is set for a specific user and the historical data indicates when he 

logged in and out, as well as specific transactions that were edited by Craig Carlson.

3. Click the gear icon to select columns to view. 

4. Click view to see details for a specific transaction.
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Closing Date

Close the books 

This is a great feature that allows you to close a period and assign a password. 

Turning on this setting triggers a warning box that prevents users from changing 

historical data, a powerful fraud prevention tool. We learned about the closing date 

features when we completed the setup section of this training. 

We encourage you to use the closing date feature once you have reconciled all bank 

and credit card accounts, reviewed your financials, and filed sales tax, payroll tax or 

income tax returns. Remember to set a date and password. If a user tries to change an 

invoice or delete a transaction, etc. a warning window will pop up and require the 

password. 
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APPENDIX A 
LISTS

Customer & Vendor Profile Lists 
Memorized Transactions

QuickBooks Desktop Foundations
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Lists

Lists are a series of “like” information compiled into an organized directory. This helps save 

time and ensures that information is entered consistently and correctly. Your Chart of 

Accounts is considered a List in QuickBooks®

Click Lists from the Menu Bar. Click the List you would like to maintain.

Select the Templates List to customize forms such as Sales Receipts, Invoices and more.

To view and manage lists related to customers and vendors, click Lists from the Menu Bar. 

Click Customers & Vendor Profile Lists.

Sales Rep List is used when entering sales receipts and invoices to track commissions and 

create reports.

Payment Terms List to track all payment terms for customers and vendors.

Payment Method List to add or edit the various types of payments you accept. This is used 

when entering sales receipts or receiving payments against invoices.
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Lists

List Rules: The same name cannot appear on more than one list. If you have a vendor

that is also a customer, we recommend that you use a code such as Ecker Design-V and

Ecker Design-C. Names on the Other Name list can be reassigned to a Customer, Employee 

or Vendor List.

Changing a Name Type:

Click Lists from the Menu Bar. Click Other Names List -> Right click on the Name -> Edit 

Other Name -> Change Type

Note: The Other Names List usually contains vendor or customer names due to errors when 

setting up a new vendor or customer on the fly. It is recommended that you avoid using

this list since the names do not always appear on reports.
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Memorized Transactions

Memorized transactions are transactions that recur daily, weekly, monthly etc. This is a 

great feature when maintained properly and used to record repetitive transactions, such as 

bills, auto debits and recurring invoices.

Click Enter Bills from the Home Page.

Enter all information related to the bill. You may want to use the policy no. as the reference 

no. As it will be the same each time the bill recurs.

Use CTRL+M or click Memorize in the Ribbon Bar to save the transaction.
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Memorized Transactions

The Name field auto populates from the bill.

Select Automate Transaction Entry. QuickBooks® will automatically enter the transaction 

for you based on the following criteria.

Select/Enter How Often, Next Date (next month), Number Remaining and Days in 

Advance to Enter. Click OK.

Click Lists from the Menu Bar.

Click Memorized Transaction List.
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Memorized Transactions

The memorized bill appears in the Memorized Transaction List. Here you can view all the 

information related to the bill and when it will automatically post.

Double-Click the Memorized Transaction to open the bill, make changes or post it manually.

Right-Click the transaction from the list, then click Edit Memorized Transaction to make 

changes to default settings.

If you want to make changes to the memorized transaction, open the transaction, make the 

necessary changes, then use CTRL+M or click Edit from the Menu Bar.

Click Memorize Bill.

Note: Exit the bill without saving to avoid posting a duplicate transaction.
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APPENDIX B
File Management

QuickBooks Update Service 
Single-user/Multi-user

Backup Data 
Restore Data 

Verify and Rebuild

QuickBooks Desktop Foundations
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QuickBooks Update Service

The QuickBooks® Update Service provides an easy, automatic way for you to update your 
version of QuickBooks®.

Click Help from the Menu Bar. Click Update QuickBooks® Desktop

Click the Update Now button from the Overview Tab.

Click the Options tab to select specific areas to update and view update status.

Click Get Updates->Save.

Click the Update Now tab to select specific areas to update and view update status. 

Click Get Updates.
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Single User/Multiuser Mode

When a company has multiple users and licenses for QuickBooks® it becomes necessary to 
switch between Single-user and Multi-user modes.

Click File from the Menu Bar.

Click Switch to Multi-user Mode

Note: Switching between Single-user and Multi-user modes will close all open windows.
Changes to areas that impact all users will require you to switch to Single-user mode.
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Backup a Data File

Backing up your company file is one of the most important things you can do to manage 
your data. It is recommended that you backup your data online or on a device that can be 
stored in a location outside of where your data resides. When you run the backup process 
a QuickBooks® file referred to as the “Transaction Log” is cleared out. This file gathers 
transaction data and can cause a login error when it gets too big.

Click File from the Menu Bar.

Click Create Copy 

Select Backup Copy. 

Click Next.

Note: A Portable Company File is typically used for larger data files. Your Accountant may 
request the Accountant’s Copy backup. Be sure to discuss the limitations for this option 
with your Accountant.
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Backup a Data File

Select Local Backup or click the Options button to choose a file folder and location.

In this example the data will be backed up to C:\QuickBooks Backups\

Click Ok.
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Backup a Data File

Click Use this Location.

Click Next.

Select Save it Now.

Click Next.
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Backup a Data File

Verify the Save In folder name.

Verify the File Name and Type.

Click Save -> Use this Location.

Your Backup is now complete.
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Restore a Data File

There may be a time when you need to restore a company data file. Corrupt data files are 

not uncommon and may require you to restore a previous backup. You may need to bring a 

backup to your accountant and restore the data file with the current changes.

Click File from the Menu Bar.

Click Open or Restore Company.

Select Restore a Backup Copy.

Click Next.
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Restore a Data File

Select Local Backup. Click Next.

Verify Look In folder.

Select the Backup File you wish to restore. 

Verify File Name and Files of Type. Click Open.
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Restore a Data File

Click Next.

Verify Save In folder.

Verify File Name and Save as Type. If the name is the same as an existing file you will be 

asked to overwrite the old file. Verify file name then click Save.
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Restore a Data File

In this restore example we are replacing an existing data file. 

Click Yes.

When replacing an existing data file you will be asked if you are certain you want to 

permanently delete the file.

Type YES.

Click OK.

Your data has been successfully restored.

Click OK.
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Verify and Rebuild Data

When you notice that something appears off in your QuickBooks® data file or your balance 

sheet does not balance, it is time to run a verify and rebuild.

Click File from the Menu Bar.

Click Utilities.

Click Verify Data.

Allow the verify process to complete. No problems with your data means you can continue 

working. Click OK.

Note: If you receive a window box that indicates QuickBooks® detected a problem with 

your data, you will need to run a rebuild.
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Verify and Rebuild Data

If QuickBooks® detects a problem with your data file during the verify process, run a 

rebuild, then run a verify again. If the problem still exists, you will need to contact your Pro 

Advisor/Accountant or Intuit technical services.

Click File->Utilities->Rebuild Data.

In order to complete the Rebuild Data process you will need to run a backup of your data 

file. Click OK.
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Verify and Rebuild Data

Verify the Save In folder.

Verify the File Name and Save as Type.

Click Save.

As soon as the Rebuild Data process is complete click View Results or Close and repeat the

Verify Data process.
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APPENDIX C 
HELPFUL TIPS

Multiple Windows 
Open Window List 

Multiple Monitor Support

QuickBooks Desktop Foundations
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Multiple Windows

How you view windows is a personal preference. You can display several open windows at 

the same time, one at a time or in a list.

Click View from the Menu Bar.

Select Multiple Windows.

For this example: The Vendor Center, Enter Bills, and Unpaid Bills Detail report windows 

are open at the same time. Simply drag the window with your mouse to reposition it on 

the display.
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Open Window List

The Open Window List used with the One Window Option is a nice feature. This combo 

option allows us to bounce between screens and reports without losing customizations or 

when you need to research historical data while entering information in a transaction.

Click View from the Menu Bar. 

Select Open Window List and the 

One Window option.

When the Open Window List becomes too

long or unmanageable, click Window in 

the Menu Bar. Click Close All.

Notice the Home 
Page and selected 
Reports are available 
in the Open Window 
List.
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Multiple Monitor Support

Using Multi-Monitors can save time and increase productivity. This option allows you to 

drag open windows from one monitor to another.

Click View from the Menu Bar->Multiple Windows

Click View->Switch to Multi-Monitor Mode. Select two to three monitors->Proceed. You

may be prompted to adjust your display settings. Click Close.

Note: visit this URL for additional information using Multiple Monitors. 

https://community.intuit.com/articles/1570286-mms-overview-of-multi-monitor-mode
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APPENDIX D 
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QuickBooks Desktop Foundations
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Glossary of Terms

Accounting and Reporting

https://community.intuit.com/articles/1164870-glossary-of-terms-accounting-and-reporting

Income – Money earned from sale of your products or services is recorded as income.

Expense – An account that tracks and categorizes what your company is spending.

Cost of Goods Sold – The Cost of Goods Sold account is for costs directly related to 

producing a service or product for sale.

Asset – Assets include something you have purchased in the past that will be used in the 

future to produce income.

Bank – Bank accounts are used to track cash moving in and out of the business.

Other Current Asset – This account type is typically used for Inventory, undeposited Funds,

Employee Advances etc.

Fixed Asset – Used to track tangible property that will have a useful life of longer than one 

year.

Other Assets – Intangible assets that have life of more than one year and is not a Fixed 

Asset or Current Asset.

Liability – Liabilities are your company’s debts.

Current Liabilities – Debts your company expects to pay within a year. Ex. Sales Tax, Payroll 

Tax, Credit Cards.

Long-Term Liabilities – Debts your company expects to pay off in more than one year. Also 

referred to as Note Payable.

Equity – Equity is the net work of a company. This is the difference between what you owe 

(liabilities) and what you have (assets).
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Glossary of Terms

Accounts Receivable - This account type requires a Customer with each entry. Use this 

account to generate and track the money owed to you by your customers.

Accounts Payable – This account type requires a Vendor with each entry. Use this account 

to generate and track money you owe to vendors or suppliers.
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People

Customers – People who owe you money.

Vendors/Suppliers – People who owe you money. 

Employees – People who work for you that you pay regularly



Keyboard Shortcuts
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Diamond Click and drag items on lists

Escape Cancel transaction, Close window

Space Bar Mark or unmark check boxes

Up Arrow Moves to line above detail area

Down Arrow Moves to line below detail area

Tab Moves to next field

Shift + Tab Moves to previous field

Alt + F4 Exit

Ctrl + A Chart of Accounts

Ctrl + C Copy

Ctrl + D Delete transaction

Ctrl + F Find transaction

Ctrl + I Create invoice

Ctrl + J Customer Center

Ctrl + M Memorize transaction

Ctrl + O Copy transaction from register

Ctrl + P Print

Ctrl + Q Quick report of highlighted list item



Keyboard Shortcuts
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Ctrl + R Use register of highlighted item

Ctrl + S Save Transaction

Ctrl + T Memorized transaction list

Ctrl + V Paste transaction in register

Ctrl + W Write checks

Ctrl + X Cut

Ctrl + Alt + M Switch to multiple monitor mode

Ctrl + Alt + V Paste a line on an invoice

Ctrl + Del Delete line Item

Ctrl + Ins Insert line Item

Ctrl + Page Up 1st item on register previous month

Ctrl + Page Down Last item on register next month

Ctrl + Enter Records transaction

Ctrl + Alt + Y Copy a line on an invoice

F1 QuickBooks® Desktop Help

F2 Product Information

F3 Search
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